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Discover The 

Seven (7) Key Benefits 

Our mission is to provide you the best computer training manuals available, at the very best price.  Discover the Seven (7) key benefits of our CompleteVISUALTM step-by-step computer training manual, and compare them with what is available from our competitors. If you need further information, please contact us at info@computertrainingmanual.com or visit our web site at http://www.computertrainingmanual.com
	Unlimited Printing Rights 

	A single payment for our manuals allows you to print as many copies as you required and distribute the printed copies for use at the designated sites.  Imagine how much money you could save by not having to purchase individual textbooks for each user!
Other courseware: There are many computer training manual providers charge on per-book per -student basis. 

	No Annual Renewal Fees

	You can continue to use any manuals you have purchased for as long as you like. You do not have to pay an annual renewal license to keep using the manuals that you have purchased the rights to! 
Other courseware: You must renew your license for a nominal annual renewal fee after 1 year from the original purchase date.

	Affordable 

	Each comprehensive title only cost you less than US$200, and remembers - UNLIMITED PRINTING RIGHTS! Our manuals are affordable to all categories of computer training, includes commercial training companies, government agencies, internal company training departments, individual setting up their own computer training program, universities, colleges and school student. 
Other courseware: There are other training manuals with unlimited printing rights, but it cost you US$350-850 for each title. 

	Complete Visual Step-by-step

	The first ever-created complete visual manuals, with every single step fully illustrated by colorful diagrams, tables and screen snapshot to show how it looks on screen.  You are unlikely to make mistakes and can even learn without a computer!
Other courseware: Only text instructions with no or only few illustration diagrams for all steps.  You may not able to follow the step closely. 

	Easy To Understand 

	Our computer training manuals are written in non-technical writing style that is easy to understand. Complicated tasks are simplified for easier understanding and reference.  90% of the tasks in each chapter fit into a single page. All tasks are summarized to less than 10 steps with no irrelevant steps.
Other courseware: There are always too many repeating and irrelevant steps involved to perform a simple task.

	Independent and Flexible Hands-on Lessons

	No pre-installed files for all lessons. All lessons in the manuals are independent.  You are flexible to start any chapter you wish without having to finish the previous lessons.
Other courseware: Lessons are totally dependent on pre-installed files and dependent very much on the previous lessons outcome.

	Completely Customizable

	You can remove and rearrange the content of the manuals as you wish.  The table of content and the page numbering are updated automatically.  You can even add your organization's name and logo to help you build a more reputable and professional image.

Other courseware: Many training manual providers claim that their manuals are easy to customize, in fact they are NOT because their lessons and exercises are all interrelated. 


The Leader Of Computer Training Curriculum and Lesson Plans
	

	


	
	

http://www.computertrainingmanual.com


Evaluation
 Version
All freely downloadable evaluation versions of our manuals are for evaluation purpose only and MUST NOT BE USED FOR TRAINING. All evaluation versions of the manuals can be viewed and printed.

If you would like to purchase the full version of our manuals, please visit http://www.computertrainingmanual.com/order.htm or contact us at order@computertrainingmanual.com for further information.

Send your comments and suggestions to suggestion@computertrainingmanual.com
	Copyright Notice

Copyright (2001 EBook Publishing. All rights reserved. No part of this publication may be reproduced, transmitted, or translated into any language, in any form or by any means, electronically or mechanical, including photocopying, recording, storage in a database or retrieval system, or otherwise, without the prior written permission of EBook Publishing.

Disclaimer

We take great care to ensure the accuracy of these material; however, EBook Publishing makes no warranty, express or implies, including without limitation any warranty concerning the adequacy, accuracy or completeness of such information or material or the results to be obtained from using such information or material. EBook Publishing reserves the right to revise this publication and to make changes in its content at any time, without obligation to notify any person or entity of such revisions or changes.


The CompleteVISUALTM step-by-step computer training manual is specially developed and organized based on the Instructional Design concepts, to ensure the effectiveness of the knowledge transfer.  

Most of the tasks in each chapter are fit into a single page for easy reference.  Most tasks are summarized to less than 10 key steps and accompanied with actual screen illustrations. Every step you go through is practical and relevant. All chapters are independent.  No exercise files need to be installed prior to the training. Therefore, you can start training from any modules that best suit you or your trainees.  However, you are recommended to follow the module sequence that we suggest to optimize your computer learning process.
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	Instructional Actions
	You are asked to

	Click File >> Save.
	Click the File menu to pull down the menu, then click the Save command from the pull down menu.

	Press <Shift>+<Tab>
	Hold down the Shift key while pressing the Tab key on the keyboard.

	Type Photo from Kevin Jeff.
	Type the phase Photo from Kevin Jeff.
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	Managing Files
	
	Objectives:

When you have completed these lessons, you will be able to:

· Open Windows Explorer

· View Folders And Files From The Hierarchical Structure

· Select Different Views For Files And Folders

· View File Extensions

· Create Folder

· Duplicate The Folder

· Rename Folder

· Save File In Folder

· Create File In Windows Explorer

· Select Multiple Files In Windows Explorer

· Move File To Another Folder

· Copy File To Another Folder

· Copy File To A Diskette

· Delete File

· Delete Folder

· Undelete / Restore Deleted File From Recycle Bin

· Empty Recycle Bin



	


Viewing The Files Using Window Explorer

The Windows uses hierarchical system to manage the files:
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As the example above, there are 5 objects on the Desktop.  3 objects are found in the My Computer object.  In the Hard Disk (C:), there are 3 folders: My Documents, Programs Files and Windows folders.  These folders contains files or subfolders.  You can view or store your files anywhere you want, on the Desktop, in the folders or subfolders.  

The following window is the hierarchical structure displayed using windows explorer. You can view the files on the right pane when you click at the folder on the left pane.
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	How To Open Windows Explorer


1. Click Start >> Programs >> Windows Explorer to open the Windows Explorer.

2. Click icon on the left pane and the right pane displays the content of the icon.

3. Click and drag the divider of the two panes to adjust the width of the pane.


· You can also right-click at the Start button on the taskbar and select Explore from the shortcut menu.


	1. Click Start >> Programs >> Windows Explorer.
The Windows Explorer window is open.
2. Click the hard disk (C:). 
Windows explorer shows the folders and files in the hard disk drive C: as shown below.  Note that your computer may have different content from the illustration.
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3. Position the mouse pointer to the divider between left pane and the right pane.
The pointer changes to the double-headed arrow, as shown below:
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4. Click and drag the divider to the right.
This is to enlarge the navigation pane, as shown below:
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	How To View Folders And Files From The Hierarchical Structure


1. Click Start >> Programs >> Windows Explorer to open the Windows Explorer.

2. Click the folder name on the left pane.

3. Click + sign on the left of the folder icon to expand and view all subfolders in a folder.

4. Click - sign on the left of the folder icon to collapse and hide all subfolders in a folder.


· Only folders with the + sign contains subfolder. 


	5. Click Start >> Programs >> Windows Explorer. Click the Program Files folder on the left pane.
The right pane is updated to show the Program Files folder content.
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6. Click the + sign on the left of Program Files folder.
The plus sign indicates that the Program Files folder contains subfolders.
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The Program Files folder is expanded to show all subfolders, as shown below.  Note that the + sign is changed to a – sign.
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7. Click the Microsoft Office Folder to see the content of the Microsoft Office folder.
The content is shown on in the view pane.
8. Click at the - sign on the left of Program Files folder.
The Program Files is collapsed to hide the subfolders in Program Files folder.
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	How To Select Different Views For Files And Folders


1. Click Start >> Programs >> Windows Explorer to open the Windows Explorer.

2. Click the View drop down arrow and click the View you want.


· To view the details of the folder or the files, click at the icon.  The details are shown on the left space under the (C:).


	9. Click Start >> Programs >> Windows Explorer.  Click the View drop-down arrow on the Standard toolbar.
Click at the C: in the navigation pane to view all the files in the hard disk before you select the different views.  Note that currently the List View is selected. 
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10. Click Small Icons from the drop-down menu.
The Window Explorer displays the content as small icons.
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11. Click Large Icons from the drop-down menu.
The Window Explorer displays the content as large icons.
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12. Click Details from the drop-down menu.
The Window Explorer displays the content with its details.
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	How To View File Extensions


1. Click Start >> Programs >> Windows Explorer to open the Windows Explorer.

2. Click View >> Folder Options.

3. Click View tab.

4. Click the Hide file extensions for known file types check box to uncheck the option.

5. Click the OK button.


	13. Open Windows Explorer in List View.
The Window Explorer displays the files without file extensions.
[image: image16.png](c)

Select an item to
View its description.

Wy Dostments
03 Program Fies
Cwindons

B butcerec
Flauoeree

B utcerec
]Bootiogprv

] setupsig
2] Suhdiog
[ system1st

Boatiag
Ecommand

[ Confir




14. From the menu, click View >> Folder Options.  Click the View Tab.
The folder options dialog box is displayed, as shown below.
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15. Under the Advanced settings list box, click the Hide file extensions for known file types check box.
The tick mark in the check box is removed and option is unchecked.
16. Click the OK button.
The Window Explorer displays the files with file extensions.
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Managing Files And Folders

The disk storage is just like a file cabinet.  You probably have hundreds of files to be kept in the cabinet.  It will be easier for you to store or retrieve your files if you organize your files well.  Folders or subfolders (folders in another folder) are like drawers for the cabinet, which could be created to organize your file.  New folders could be created when necessary as you add files onto the disk.  Most applications store the files that you create in a default folder.  However, you can create you own folders to keep your files.

Every folder has a unique name within the same hierarchy level.  Whenever you add a new folder, make sure you are at the correct location in the hierarchy.  The folder or subfolder name can consist of up to 255 characters.  Special characters (\ / : , * ? “ < > |) cannot be used as the folder name.  

You can reorganize the files into different folders or different disk storage using windows explorer.  You can move or copy the files into a new folder.  Moving files is to transfer the files from one location to another, while copying creates identical copies of the original files into another location.
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	How To
Create Folder


1. Click Start >> Programs >> Windows Explorer to open the Windows Explorer.

2. Click the location at where you want to create the folder.

3. Right-click the blank area at the right pane.

4. Click New >> Folder from the shortcut menu.

5. Type the folder name.

6. Press <Enter>.


· You can also click at the location, and then click File >>
New >> Folder from the menu to create a new folder.


	17. Click the My Documents folder in the navigation pane.
You want to create a folder in the current My Documents folder.
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18. Right-click the blank area at the right pane.  Click New >> Folder from the shortcut menu.
A folder with the name New Folder is created, as shown below:
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19. Type training as the name of the folder.  Press <Enter> key.
The name is updated to the new name.
[image: image23.png]My
Documents

New Folder
File Folder




20. Click the + (plus sign) on the left of My Documents folder in the navigation pane.
The folder you just created is displayed, as shown below:
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	How To Duplicate
The Folder


1. Select the source folder at the right pane.

2. Click the Copy button.

3. Click at the destination folder.

4. Click the Paste button.


· You can also use <Ctrl>+C to copy and <Ctrl>+V to paste the folder.


· When you copy the folder, all the files and subfolders in that folder are copied to the destination location. 


	21. Click the Training Folder.
You want to duplicate the folder.
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22. Click the Copy button on the toolbar.
The folder is copied onto the clipboard.
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23. Select the destination folder.
In this case, the destination is the same folder.
24. Click the Paste button on the toolbar.
A copy of the folder is pasted with the name `Copy of Training’ because the name already exists in the same folder.
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	How To
Rename Folder


1. Right-click at the folder icon.

2. Click Rename from the shortcut menu.

3. Type the new folder name.

4. Press <Enter>.


· You can also click the folder and press <F2> to rename the folder.


	25. Right-click at the Copy of Training folder.  Click Rename from the shortcut menu.
You want to rename the folder name from Training to Microsoft Training.  The name is highlighted.
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The folder name is in edit mode.
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26. Type Microsoft Training as the new folder name.
A new name replaces the highlighted text.
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27. Press <Enter>.
The new folder name is confirmed.



	How To Save File In Folder


1. Click File >> Save As from the application menu.

2. Type the File name.

3. In the Save in: box, select the location you want to save the file.

4. Click the Save button.


	28. Click Start >> Programs >> Accessories >> Notepad.  Type Save this file in C:\My Documents\Training folder.
You want to create a file using Notepad.
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29. From the menu, click File >> Save As.
The Save As dialog box is displayed, as shown below:
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30. In the File name box, type Lesson 1.
This is to save the file under the name Lesson 1.

31. Double-click the Training folder from the list.
The training folder is open. You want to save the file in the Training folder.
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32. Click the Save button.
The file is saved in the C:\My Documents\Training folder.




	How To Create File In Windows Explorer


1. Open Windows Explorer.

2. Click at the folder where you want to place the file.

3. Right-click the blank space at the right pane.

4. Click New >> Text Document from the shortcut menu.

5. Rename the new file.


	33. Open C:\My Documents\Training in Windows Explorer.  Click at the folder where you want to place the file.
To open the Windows Explorer, right-click at Start Button, click Explore.
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34. Right-click the blank space on the right pane.  Click New >> Text Document from the shortcut menu.
The quick menu is displayed.
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A blank text file name New Text Document is created.
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35. Rename the new file from New Text Document to Lesson 2.
Right-click at the file name and select Rename from the shortcut menu.

36. Create and rename a few more text files in the folder.
The files appear as shown below:
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	How To Select Multiple Files
In Windows Explorer


1. Open Windows Explorer.

2. Click at the first file name.

3. Hold down the <Shift> key.

4. Click at the last file name.

5. Hold down the <Ctrl> key if you want to select non-adjacent files.


	37. Open C:\My Documents\Training in Windows Explorer.
Right-click at Start Button.  Select Explore from the shortcut menu.
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38. Click the Lesson 1.
The file - Lesson 1 is selected, as shown below:
[image: image39.png]5] teson?
] tessons

Training  Bteent




39. Click the Lesson 2.  Hold down the <Shift> key and click the Lesson 4.
The files - Lesson 2 to Lesson 4 are selected, as shown below:
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40. Click the Lesson 1. Hold down the <Ctrl> key and click the Lesson 3.
Only Lesson 1 and Lesson 3 are selected, as shown below:
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	How To Move File To Another Folder


1. Select the files you want to move.

2. Click the Cut button.

3. Click the destination folder.

4. Click the Paste button.


· If you want to move multiple files, select all the files before moving.


· You can also use drag and drop method.  For example, drag the Lesson 4 on the right pane and drop it on the Microsoft Training folder on the left pane.


	41. Click the Lesson 4 to select it.
You want to move the file Lesson 4 to Microsoft Training folder.
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42. Click the Cut button [image: image43.png]Cut



on the toolbar.
You can also press <Ctrl>+<x> on keyboard to cut.  The cut file icon is dimmed, as shown below:
[image: image44.png]0 Loswon?





43. Click the Microsoft Training folder.
Microsoft Training folder is the destination of the copied file.
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44. Click the Paste button [image: image46.png]Faf
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 on the toolbar.
You can also press <Ctrl>+<v> on keyboard to paste.  The file is moved into Microsoft Training folder.  Lesson 4 is no longer found in the Training folder.
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	How To
Copy File To Another Folder


1. Select the files you want to copy.

2. Click the Copy button.

3. Click the destination folder.

4. Click the Paste button.


· If you want to copy using drag and drop method, you need to hold down the <Ctrl> key before you release the mouse at the destination folder on the left pane.


· If the destination location has already have a file with the same name, you will be prompted to confirm whether you want to overwrite the file.


	45. Select Lesson 1 and 2 in Training folder.
You want to copy the files Lesson 1 and 2 to Microsoft Training folder. To select the files, click Lesson 1, hold down the <Ctrl> key and click Lesson 2.
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46. Click the Copy button [image: image49.png]Copy



 on the toolbar.
You can also press <Ctrl>+<c> on keyboard to copy.  The cut file icon is dimmed. 
47. Click the Microsoft Training folder.
Microsoft Training folder is the destination of the copied file.
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48. Click the Paste button [image: image51.png]Faf
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 on the toolbar.
You can also press <Ctrl>+<v> on keyboard to paste.  The file is moved into Microsoft Training folder.  Lesson 4 is no longer found in the Training folder.
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	How To
Copy File To
A Diskette


1. Select the files you want to copy.

2. Right-click at the highlighted files.

3. Click Send To >> 
3½ Floppy (A) from the shortcut menu.


· You can also drag the highlighted files on the right pane and drop it on the 3½ Floppy (A:) on the left pane.


	49. Select Lesson 1 and 2 in Training folder.
You want to copy the files Lesson 1 and 2 to the diskette. To select the files, click Lesson 1, hold down the <Ctrl> key and click Lesson 2.
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50. Right-click at the selected files. 
The quick menu is displayed.
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51. Click Send To >> 3 ½ Floppy (A) from the shortcut menu.
The files are copied onto the diskette.  Make sure there is a diskette in your floppy disk drive.  If your disk drive is empty, an Error Copying File dialog box is displayed, as shown below:
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	How To
Delete File


1. Select the file(s) you want to delete.

2. Press <Delete>.

3. Click the Yes button.


· All the deleted files and the folders are stored in the Recycle Bin until you clear the Recycle Bin.

· If you do not want to send the deleted files to recycle bin but remove permanently, hold down the <Shift> key and press <Delete>.


	52. Click the Lesson 1 in the Microsoft Training Folder.
You want to delete the file Lesson 1.
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53. Press <Delete>.
A Confirm File Delete dialog box is displayed to get your confirmation.
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54. Click the Yes button.
The file Lesson 1 is deleted.


	How To
Delete Folder


1. Click the folder you want to delete.

2. Press <Delete>.


	55. Click the Microsoft Training Folder.
You want to delete the folder.
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56. Press <Delete>.
The Confirm Folder Delete dialog box is displayed to get your confirmation.
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57. Click the Yes button.
The folder is deleted.


Managing Recycle Bin

Whenever you delete a file, the file is not deleted permanently but sent to the Recycle Bin.  This is a very useful safety feature that enables you to recover the deleted files from the Recycle Bin.  The files remain in the Recycle Bin for as long as they do not exceed the disk capacity specified for the Recycle Bin, or until you instruct the system to empty the Recycle Bin.  You can also specify not to move files to the Recycle Bin but remove files immediately when deleted.  

To set the Recycle Bin properties, right click at the Recycle Bin icon on the desktop.  Select Properties from the quick menu and the Recycle Bin Properties dialog box is displayed as illustrated.
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	How To Restore Deleted File From Recycle Bin (Undelete)


1. Click the Recycle Bin at the left pane in Windows Explorer.

2. Right-click the file to recover at the right pane.

3. Click Restore from the shortcut menu.


· You can also double- click the Recycle Bin on the desktop to see the content of the Recycle Bin and restore the file you want.


	58. Click the Recycle Bin at the left pane.
All deleted files are displayed on the right pane.
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59. Right-click at the Lesson 1 file.  
You want to restore the file back to the original location.  You can see the original location on the right pane, as shown below. 
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60. Click Restore from the shortcut menu.
The file is removed from the recycle bin and is sent back to the original location.


	How To Empty Recycle Bin


1. Right-click at the Recycle Bin on the left pane.

2. Click Empty Recycle Bin from the shortcut menu.

3. Click the Yes button.


· If you want to remove only some of the files in the Recycle Bin, double- click to open the Recycle Bin.  Hold down the <Ctrl> key and click each file you want to remove, and then press <Delete> key on the File menu.


	61. Right-click at the Recycle Bin on the left pane.
The shortcut menu is displayed, as shown below:
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62. Click Empty Recycle Bin from the shortcut menu.
A Confirm File Delete dialog box is displayed to get your confirmation of permanently deletes the Microsoft Training folder.
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If you have more than 1 file or folder in the recycle bin, Confirm Multiple File Delete dialog box is displayed to show the number of files in the recycle bin, as shown below: 
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63. Click the Yes button.
The recycle bin is cleared.


Exercises

Managing Files

1. Create a new folder: Company in your hard disk C:

2. Create 3 new subfolders: Human Resource, Production and Finance in Company folder.

3. Create 2 new files: Employee.txt and Expenses.txt in Human Resource subfolder.

4. Create a file: Salary.txt in Finance subfolder.

5. The file structure is shown as illustrated.
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6. Duplicate Production folder and rename the new folder Purchases
7. Move the Expenses.txt file to Finance folder.

8. Copy the Salary.txt file to Human Resource folder.

9. Copy the Employee.txt file to a diskette.

10. Delete Production folder.

11. Delete Employee.txt and Expenses.txt from Human Resource. (Select 2 files and press <delete>) 

12. Restore the Employ.txt from the Recycle Bin.

13. The file structure is modified as illustrated.
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Task Name.  Each task consists of a series of fully illustrated step-by-step instructional actions, which helps you to follow the hands-on activities precisely.





Visual step-by-step instructional actions show you the hands-on activities to accomplish the task.  These instructional actions appear as such.





The important commands or keywords are highlighted as such.





The texts that you need to type in appear as such.





Actual screen captured illustration such as the dialog boxes and the result outcomes are displayed to show you how they would appear on screen.  This helps you to learn visually and effectively.





A thick rectangle or circle is used to draw your attention to the part of the illustration that you are dealing with.





Detailed descriptions and explanations on each step help you to learn more about the step that you have just performed. 





Handy summary.  Each task concludes with a summary that reinforces the key steps in the task.  It also serves as cue card for a specific task.  





Appropriate tips, tricks, and shortcuts that you may find useful are included to further enhance your skill.





Section name.  Each section groups the related chapters under the same section to make sure you learn all the related features and skills in complete details.





Chapter name. Each chapter is an independent learning unit.  No exercise files need to be installed prior to the training.  This lets you start your training anywhere or anytime you like.





Chapter introduction. Each chapter begins with a presentation and illustration to present the concepts you need to have a better understanding of a chapter before you begin.
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